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Some of the solutions presented in this booklet use techniques that are not included in the current CAT 

curriculum. They are presented here as alternative methods for solving the problems. It is hoped that teachers 

and participants (learners) will look at the methods used and consider using them in their Practical 

Assessment Tasks which, in a sense, are open-ended and where use can be made of techniques not included 

in the curriculum (see Assessment Criteria 6 and 10 of Phase 2 of the DBE’s 2020 PAT for Grade 12). 

A: WORD-PROCESSING 
Use the document Track and Field.docx to answer the following questions.  

 

A1   How many sections are there in the document? 5 

Method 1: Show hidden characters and count 
Ensure that hidden characters such as page and section breaks are visible. Click on the ‘Show/Hide ¶’ 
icon in the ‘Paragraph’ group of the ‘Home’ tab (see Figure 1). 

 
Start on the first page of the 
document and scroll down 
looking for section breaks 
(see Figure 2). Three section 
breaks are found on Page 3 
of 7 (two continous and one next page). A further next page section 

break is found on Page 5 of 7. This gives a total of four (4) section breaks. This means that there are three 
sections between the section breaks, one section before the first section break and one section after the 
fourth section break. This give a total of  five (5) sections in the document. 
 
Method 2: Advanced Find 
Make sure your cursor is on the first page of the document before using this method. 
 

Select Advanced Find by either clicking on ‘Advanced Find..’ under the ‘Find’ 
dropdown in the ‘Editing’ group of the ‘Home’ 
tab (see Figure 3) or selecting ‘Advanced 
Find…’ from the ‘Search Document’ 
dropdown found in the ‘Navigation’ pane (see 
Figure 4). You can also use the <Ctrl><F> 
shortcut and then choose ‘Advanced Find’. 

 
 

 
In the ‘Find and Replace’ dialog box click the ‘More >>’ 
button to show the ‘Search Options’. Click on the ‘Special’ 
button and click on ‘Section Break’. The search string ‘^b’ 
will be inserted next to ‘Find what:’ (see Figure 5).  
 
Click the ‘Find Next’ button to move to the first section 
break. Repeat this process until you reach the end of the 
document. You will find that there are four section breaks 
in the document giving five (5) sections (see Method 1). 
 
 
 
 
 
 
 

Figure 1 

Figure 2 

Figure 3 

Figure 4 

Figure 5 
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Alternatively you can click the ‘Reading 
Highlight’ button and select ‘Highlight All’ (see 
Figure 6). A message will appear that says 
‘Word highlighted 4 items.’ (see Figure 7). 
 

This shows that there are four (4) section breaks which gives five (5) 
sections. 
 
Method 3: Page header or footer 

Scroll to the last page of the document ( or press <Ctrl><End>). Select either the 
header or the footer on the last page. Either double-click in the header or footer or 
right click and choose ‘Edit Header’ (or Footer). On the left of the header (or footer) 
you will see an information box which shows ‘Header -Section 5-’ or 
‘Footer -Section 5-’ (see Figure  8). 
 

This shows that there are five (5) sections in the document. 
 
Close the ‘Header and Footer’ tab before answering the next question. 

A2 Alternative (Alt) text is often added to pictures in a document to make 
them accessible to people using a screen reader to read a document. How 
many pictures in this document do not have alternative text? 

A2   Alternative (Alt) text 

1 

Method 1: Edit Alt Text 
There are five pictures in the document. The first 
picture is found on the title page. Right-click on the 
picture and select ‘Edit Alt text’ from the right-click 
menu (see Figure 9). 
 
The ‘Alt Text’ pane appears to the right of the 
document.  
 
There is no description for the first picture (see 
Figure 10). Repeat for the other four pictures. Each 
one will be found to have alternative text added. Thus 
only one (1) picture does not have alternative text. 
 

 
Method 2: Inspect document 

Click the ‘File’ tab to go to the Backstage View of the document. On the left click on ‘Info’ (see 
Figure 11).  
 
On the ‘Info’ page locate the ‘Inspect Document’ heading. Under 
this heading click the ‘Check for Issues’ button and select 
‘Check Accessibility’ (see Figure 12). 
 
 
 
 
 
 
 

 
 
 

Figure 7 

Figure 6 

Figure 8 

Figure 9 Figure 10 

Figure 11 
Figure 12 
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The ‘Accessibility Pane’ opens on the title page of the document. 
Under the heading ‘Errors’ one (1) picture (Picture 1) is identified 
as having missing alternative text (see Figure 13) If you click on 
Picture 1, the picture on the title page wil be selected. 
 
Group 453 refers to the rectangular shapes which form part of the 
title page. This is not a picture and should not be counted. 

A3 How many times does the word ‘track’ or ‘Track’ appear in the 
document? The word must NOT immediately be followed by a punctuation 
mark (e.g. comma or full stop), a character such as a hyphen or underscore, 
or the words ‘and field’. 

A3   Count occurrence of a word 

11 

Method 1: Count 
Open the ‘Find and Replace’ dialog box as described 
in question A1. In the ‘Find what:’ box type in “track “ 
– note that there should be a space after the word 
‘track’ so as to exclude punctuation marks and other 
characters immediately after the word ‘track’ (see 
Figure 14). 
 
Start at the top of the document. Click the ‘Find Next’ 
button to select the first instance of “track “. Repeat 
and count all the cases where “track “ is NOT followed 

by the words “and field”. You should get a total of 11. 
 
While this method will provide the correct answer it is both prone to error and time-consuming. In a longer 
document it would not be a very efficient strategy to use. 
 
Method 2: Reading Highlight 

Proceed as in Method 1 and type in the word “track “ (track followed by a 
space) into the ‘Find what:’ box. Click the ‘Reading Highlight’ button and 
choose ‘Highlight All’ (see Question A1 Method 2). A message will appear 
showing that 34 items have been highlighted (see Figure 15). These 34 items 
include all the cases where ‘and field’ follow the word ‘track’. 
 

 
Now replace the search string “track “ with “track and field”. Use Reading 
Highlight to highlight all these instances. Word will highlight 23 items (see 
Figure 16). 
 
Therefore the number of instances of the word ‘track’ that are required is equal 
to 34 – 23 = 11. 

 
 
 

Figure 13 

Figure 14 

Figure 15 

Figure 16 
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A4 How many times in the document is there a four digit number followed 
by a space e.g. “1500 ” or “2020 ” etc. 

A3   Count occurrence of a four digit number 

4 

Method 1: Count 
Starting from the beginning of the document scan each page carefully and count all the occurences of four 
digit numbers followed by a space. All four (4) numbers are to be found on Page 2 of 7. 
 
As was the case with Question A3, this is not an efficient way to find the answer and is also prone to errors. 
 
Method 2: Advanced find 

Open the ‘Find and Replace’ dialog box as described in Question 
A1. Ensure that the ‘Search Options’ are visible. Click in the ‘Find 
what:’ box. First type a space, then click on the ‘Special’ button and 
click on ‘Any Digit’ (see Figure 17). The search string ‘^#’ is added.  
Repeat another three times (or type in three more ‘^#’) and then add 
a space to finish. 
 
Note that if a leading space is not included in the search string, then 
five or six digit numbers will also be found. 
 
There are four (4) four digit numbers followed by a space to be found 
in the document. 

  

Figure 17 
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B: SPREADSHEET 
Each year Athletics South Africa hosts the national championships. The spreadsheet 

CAO 2020 Round 2.xlsx contains the information of some of the individual athletes who registered to 

compete in the championships. Use the information in the Athletes worksheet to answer the questions that 

follow.  

Information about the data stored in each column (fields) is given in the (Field) Descriptions worksheet. You 

should take time to study this information before attempting to answer the questions. 

Before answering any spreadsheet questions, open the spreadsheet and select 

the ‘Athletes’ worksheet. Go to the ‘Data’ tab and click on the ‘Filter’ icon in the 

‘Sort and Filter’ group. This enables filter drop-downs for each column (field) in the 

athletes data. 

When you have used filtering to answer a question, remember to click the ‘Clear’ button to reset the data to 

its original state. 

The data set in the spreadsheet is quite large. When you are working with large data sets it is inefficient and 

time-consuming to drag a formula from the first cell to the last in a range. One of the following methods of 

working is recommended: 

• Use the keyboard shortcut <Ctrl><Shift><Down> to select a long range of data. Click in the top cell 

and apply the shortcut. This will select the whole range. You can also use <Ctrl><Down> and 

<Ctrl><Up> to jump to the bottom or top of a column of data. 

• Inspect the data in the spreadsheet before you start answering questions and note that the last row 

with data is row 1337. You can then easily type in ranges such as E2:E1337 without any dragging. 

B1   Which ONE of the following events has the slowest qualifying time?  
(a) 100 m for junior males  
(b) 100 m for junior females  
(c) 100 m for male youths  
(d) 100 m for female youths 

(d) 

Method 1: Filter 
Work in the Athletes worksheet. Set up filters on the following columns (fields): 
Category Deselect ‘Sub-Youth’ (leaving ‘Junior’ and ‘Youth’ categories) 
Event  Select only ‘100m’ 
 

Go to the Qualifying column and click on the drop-down filter. There are four 
qualifying times. The slowest time is 15.58 (see Figure 18). Select only 15.58 and 
click ‘OK’. 
 
Inspect the Athletes 
worksheet. This will show 
that the slowest qualifying 
time of 15.58 is for the 100 m 
for female youths (see 
Figure 19). This is answer (d).  
 
Instead of filtering for the qualifying time column, this column can be sorted in 
descending order. The same result as in Figure 18 will be seen. 
 
Clear all filters/sorting before proceeding. 

 
Method 2: Pivot Table 

Figure 18 

Figure 19 
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Click in any cell in the Athlete data on the Athlete worksheet (e.g. cell A2). Go to 
the ‘Insert’ tab and click on ‘Pivot Table’ in the ‘Tables’ group (see Figure 20).  
 

In the ‘Create PivotTable’ dialog box accept all the 
default settings and click ‘OK’. A blank PivotTable 
will be created in a new worksheet. In the ‘Pivot 
Table Fields’ pane drag the Event field to the 
‘Filters’ box, the Categories field to the ‘Columns’ box, the Gender field to 
the ‘Rows’ box and the Qualifying field to the ‘Values’ box. In the ‘Values’ 
box click the dropdown arrow next to ‘Qualifying’ and change ‘Summarize 
value field by’ to ‘Max’ (see Figure 21). 
 
Using the ‘Event’ filter, 
select ‘100m’. Use the 
‘Column Labels’ filter to 
deselect ‘Sub-Youth. 
 

Referring to Figure 22, the slowest qualifying time can be 
seen to be 15.58, which is the qualifying time for the100 m 
for female youths event. This is answer (d). 
 
Using a Pivot Table to answer this question is rather like 
using a sledge hammer to swat a fly but the solution is included to illustrate how powerful a tool Pivot Tables 
are. 

B2   How many female athletes born in May 2005 entered the javelin event? 4 

Method 1: Filter 
Clear any existing filters before answering this question. Set the following filters 
in the Athletes worksheet: 
Gender Female 
DOB  Deselect all. Expand ‘2005’ and click on ‘May’ (see Figure 23) 
Event  Javelin 
 
For the DOB field you can also use the ‘Between’ date filter using 2005/05/01 
as the starting date and 2005/05/31 as the ending date. 
 
Four (4) records are returned. 
 
 
 
 
 
 
 
Method 2: COUNTIFS() function 
In and empty column on the right of the data in the Athletes worksheet type in 
the following formulae: 
Cell U2: =DATE(2005,5,1) 
Cell U3: =DATE(2005,5,31) 
Cell U4: =COUNTIFS(E2:E1337,">="&U2,E2:E1337,"<="&U3,D2:D1337,"Female",H2:H1337,"Javelin") 
 
Note that any empty cells can be used. 
 
The range E2:E1337 is the dates of birth of the athletes. The criterion “>=”&U2 looks for dates on or after 
1 May 2005. Note that as the inequality >= has to be in quotes the concatenation operator ‘&’ is used to 
join the inequality to the date. The second range is also dates of birth and this looks for dates on or before 
2005/05/31. The range D2:D1337 is the athlete’s gender and H2:H1337 is the event entered. 

Figure 20 

Figure 21 

Figure 22 

Figure 23 



 

 

 
 

10 

 
The function returns a value of 4. 
 
Method 3: Pivot Table 
Create a Pivot Table as described in the previous question (or modify the previous Pivot Table). On the 
‘Pivot Table Field’ pane make the following changes: 
Filters:  Gender and Event 
Columns: Any field which can be counted will do, e.g. Category 
Rows:  DOB 
Values: Index – leave the default setting at ‘Count of Index’ 

 
Set the Gender filter to ‘Female’ and the Event filter to ‘Javelin’. Set the Row 
Labels filter to ‘2005’. Expand the year 2005 and ‘Qtr2’ to show the months 
of April to June.  
 
The number of athletes for May 2005 can be seen to be 4 (see Figure 24). 
 

B3   What is the difference (in months) between the ages of the oldest and the youngest 

athlete? Give your answer rounded down to the nearest whole number. 
69 

Method 1: Date calculation 
In order to determine the number of months between the ages of the oldest and youngest athletes, their 
date of birth should be used and NOT the number in the Age Group field. 
 
Dates are stored in Excel as a serial number which shows the number of days after 1900/01/01 (not strictly 
true due to an error made in early versions of Excel with a leap year). This means that the oldest athlete 
will have the smallest date serial number and the youngest athlete will have the largest date serial number. 
 
In empty cells on the Athletes worksheet type in the following functions: 
 
Cell S2: =MIN(E2:E1337) – this gives the date of birth of the oldest athlete 
Cell S3: =MAX(E2:E1337) – this gives the date of birth of the youngest athlete 
 
Now the difference in months between these two dates can be calculated with the following formula: 
 
=(S3-S2)/365.25*12 
 
Dividing by 365.25 gives the difference in years which is converted to months by multiplying by 12. The 
formula gives a result of 69.650924. The question requires the answers to be rounded down to the nearest 
whole number which is 69. The ROUNDDOWN() function can be used to obtain the answer of 69 but this 
is not really necessary. 
 
Method 2: DATEDIF() function 
The DATEDIF() function is a function that is available in Excel in order to provide backward compatibility 
with a spreadsheet called Lotus 1-2-3 which was the forerunner of Excel. It cannot be found by searching 
using the the ‘Find function’ (fx) button. It also does not provide tool tips when you use it. There are some 
situations when it does not provide a correct answer so it should be used with caution. 
 
The function accepts three arguments – start date, end date and a code to determine whether completed 
years, months or days should be returned. 
For this question you would use: 

Figure 24 
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=DATEDIF(MIN(E2:E1337), MAX(E2:E1337), “m”) 
 
This returns the number of completed months between the date of birth of the oldest and the youngest 
athletes. An answer of 69 is returned. 

B4   How many athletes entered 3 or more events? 44 

As explained on the (Field) Descriptions worksheet the value in the Index field (column) gives the unique 
number of each athlete followed by the number 
of the event which that athlete has entered. 
 
In order to determine how many athletes entered 
3 or more events it is only necessary to count 
how many index numbers end with ‘3’. Any 
athletes who entered more than 3 events will 
already have been counted so it is not necessary 
to check any other values as those athletes have 
already been counted. 

 
A number of different methods can be used to obtain the desired answer. 
 
Method 1: Filtering 
In the Index field use the ‘Ends With…’ text filter and set the value to ‘3’. Click ‘OK’ to apply the filter (see 
Figure 25).  
 
In the ‘Status Bar’ it shows that 44 of 1336 records were found. 
 
Method 2: COUNTIF() function 
In any empty cell on the Athletes worksheets type in the following function: 
 
=COUNTIF(A2:A1337,"*3") 
 
The wildcard ‘*’ is used to search for all the Index numbers which end with ‘3’. The function returns a value 
of 44. 
 
Method 3: RIGHT function 
In an empty column to the right of the Athletes data type the following function into the cell in row 2 (top of 
the column): 
 
=RIGHT(A2,1) 
 
The function extracts the event number from the Athlete’s index. AutoFill this function to row 1337. The 
number of times ‘3’ appears can be found using a COUNTIF() function or by filtering. 44 records will be 
found. 
 

  

Figure 25 
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B5   The competition is scheduled to be held over 3 days from 21 February to 23 
February. How many male athletes will celebrate their birthdays during the 
competition? (NB. Some athletes appear more than once in the spreadsheet.) 

B5 How many will celebrate their birthday during the competition 

5 

Method 1: Date functions and filtering 
In empty columns to the left of the Athlete data type in the following functions: 
 
=MONTH(E2) 
=DAY(E2) 
 
AutoFill the functions down to row 1337 (the end of the Athlete data). The MONTH() function is applied to 
the athlete’s date of birth. The function returns a number from 1 to 12 where 1 is January, 2 is February, 
etc. The DAY() function returns the day of birth of the athlete. Give each column suitable headings such as 
‘BirthMonth’ and ‘BirthDay’. 

 
Now apply the following filters: 
 
Index  Ends With 1 (so that each athlete is only counted once) 
Gender Male 
BirthMonth 2 (selects dates of birth in February) 
BirthDay 21, 22 and 23 (the days of the competition) 
 
Five (5) records are returned (see Figure 26). 

 
It is possible to apply a filter to the DOB field but this requires expanding each year, then selecting February 
and finally selecting the dates 21, 22 or 23. This is a somewhat tedious process. 
 
Method 2: COUNTIFS function 
In any empty cell on the Athletes worksheet type in the following function: 
 
=COUNTIFS(A2:A1337,"*1",D2:D1337,"Male",P2:P1337,">=21",P2:P1337,"<=23",O2:O1337,2) 
 
Each of the ranges matches one of the filters used in Method 1. The function also makes use of the day of 
birth column added in Method 1. When searching for a range of values using the COUNTIFS() function the 
range must be used twice with one criterion for the lowest value in the range and a second criterion for the 
largest value in the range. 
 
The function returns a value of 5. 
 
Method 3: IF() function (with filtering) 
In an empty column to the right of the Athlete’s data type in the following function in row 2: 
 
=IF(AND(MONTH(E2)=2,DAY(E2)>=21,DAY(E2)<=23,D2="Male",RIGHT(A2)="1"),"Happy BDay","") 
 
The AND() function returns a value of TRUE if all five conditions are true. The conditions that are tested 
match the filters applied in Method 1. AutoFill the function to row 1337. Type a suitable heading in row 1 
and filter for ‘Happy BDay’. Five (5) records will be returned (see Figure 26 above). 
 
It is possible, but somewhat challenging, to use a nested IF() function instead of using AND(). 
 

  

Figure 26 
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B6   How many athletes had an “Achieved” time within 10% on either side of the 
national record? 

183 

Answering this question poses a number of challenges. 

• The question refers to achieved “time”. This implies that only track events should be considered 
when answering the question. 

• The achieved time can be less than or greater than the record. 

• Some athletes might reach the achieved time for more than one event. They should only be counted 
once. 

• Some athletes might not reach the achieved time for their first event but only their second (or third 
or fourth) event. These athletes must be counted as well 

 
Solving this problem requires breaking it down into separate steps. Each of these steps can be solved using 
a number of different strategies. 
 
Method 1 
Step 1: Identify achieved times with 10% of the national record 
 
In an empty column type the following formula in row 2: 
 
=ABS(J2-L2)/L2% 
 
The ABS() function returns the positive difference between ‘Achieved’ time (cell J2) and the national 
‘Record (cell L2). This means that the order in which the subtraction is done does not matter. Dividing by 
L2% calculates the difference as a percentage. This can also be done using …/L2 * 100 or just …/L2 and 
then formatting as a percentage. 

 
AutoFill the formula to row 1337. 
 
Step 2: Filter for track events 
 
The formula used in Step 1 did not distinguish between ‘Track’ 
and ‘Field’ events. Filter the Event Type field to only display 
‘Track’. This will return 959 records. 
 
Step 3: Filter for values with 10% 
 
Apply a ‘Less Than Or Equal To…’ number filter to the column 
to results of the formula added in Step 1 (see Figure 27). Type 
in a value of 10 (which might change depending on how you 
worked out the percentage in Step 1). This will now return 230 
records. 
 
 

Step 4: Identify unique athletes 
 
Each athlete has a unique index number in column 1. Copy the filtered index numbers from column 1 and 
paste them on a new worksheet (in column A). In column B type in the following function: 
 
=LEFT(A1,6) 
 
AutoFill this function to all 230 rows. The function removes the event number as the number and leaves 
only the unique athlete index. 
 

Figure 27 



 

 

 
 

14 

Select all 230 values in column B. In the ‘Data Tools’ group on 
the ‘Data’ tab select ‘Remove Duplicates’ (see Figure 28). 
 
In the ‘Remove 

Duplicates 
Warning’ dialog 
box select 
‘Continue with the 
current selection’ 

and click the ‘Remove Duplicates’ button (see Figure 29). In 
the ‘Remove Duplicates’ dialog box accept the default 
settings and click OK. 

 
A message box appears which shows that 47 
duplicate values were found and removed and 
183 unique values remain (see Figure 30). 
 
 
 
 
 

Method 2 
Using an IF() function the first two steps of Method 1 can be combined into a single step. Type the following 
function into row 2 of an empty column on the Athletes worksheet. 
 
=IF(AND(I2="Track",ABS(J2-L2)/L2*100<=10),"Achieved","") 
 
A nested IF() function can also be used instead of using the AND() function. 
 
Now filter the new column for ‘Achieved’ and 230 records will be returned. Identify the number of unique 
athletes as described in Step 4 of Method 1. 

B7   How many athletes obtained the qualifying distance/height/time for the event in 
which they wished to compete, but failed to achieve this qualifying 
distance/height/time in the actual event? 

B7 Who failed to achieve their qualifying distance/height/time? 

24 

Unlike question B6, all events are included in this question. This means that for the field events, athletes 
whose distance or height was less than the qualifying distance or height must be counted. For the track 
events athletes whose time was greater then the qualifying time must be counted. You also need to ensure 
that athletes are not counted more than once. 
 
The distance/height/time is in the Achieved field. 
The qualifying distance/height/time is in the Qualifying field. 
 
In an empty column to the right of the Athlete’s data enter the following function in row 2: 
 
=IF(AND(I2="Field",J2<K2),"Oops","") 
 
This functions checks for field athletes whose achieved distance or height was less than the qualifying 
distance or height. 
 
In another empty column enter the following function in row 2: 
 
=IF(AND(I2=”Track”,J2>K2),”Oops”,"") 
 
This function checks for track athletes whose achieved time was greater than the qualifying time. 

Figure 28 

Figure 29 

Figure 30 
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Note that in both cases a strict inequality is used because the question specifies “failed to achieve”. AutoFill 
both functions to row 1337. Apply an ends with ‘1’ filter to the Index field. Count the number of times “Oops” 
appears in each column. This is most easily done by using filtering. 
 
Nested IF() functions could be used instead of the AND() function. The function used to check the track 
athletes could be: 
 
=IF(I2="Track",IF(J2>K2,"Oops",""),"") 
 
The following results are found: 
 
Field athletes  1 Oops 
Track athletes  23 Oops 
 
This gives 24 athletes who did not achieve the qualifying distance, height or time. 
 

B8   How many events had 50 or more entrants? 10 

For this question the number of participants in each event must be counted. Athletes can be counted more 
than once, unlike many of the previous questions. 
 
Method 1: COUNTIF() function 
There are sixteen different events in the Event field. 
 
In empty cells on the Athletes worksheet type in a list of the sixteen events. This can be done using the 
filter for the Event field. Alternatively, copy all the data in the Event field, paste it on a new worksheet, 
remove duplicates (see Question B6) and paste the list back on the Athletes worksheet. Use a COUNTIF() 
function to count how many entrants there are in each event. For example: 
 
=COUNTIF($H$2:$H$1337,Z16) 
 

In this case the event name is in cell Z16. Note that absolute cell references were used 
so that the function could be copied for the other 16 events. The results obtained are 
shown in Figure 31. These results have been sorted in descending order of number of 
entrants. 
 
The number of events with more than 50 entrants can easily be counted. There are 10 
events with 50 or more entrants. 
 
A COUNTIF() function can also be used: 
 
=COUNTIF(AA16:AA31,">=50") 
 
Note that the inequality ‘>=’ should be used as ’50 or more’ events are required. In this 
case you would, however, still arrive at the correct answer with a strict inequality. This 
function will return a value of 10. 
 

 
 
 
 
 
 
 
 
 

Figure 31 
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Method 2: PivotTable 
Create a new PivotTable based on the Athletes worksheet or modify an existing 
one. 
 
In the ‘Pivot Table Fields’ pane drag the ‘Events’ field to the ‘Rows’ box and also 
to the ‘Values’ box. Leave the default ‘Count of Events’. The PivotTable shown 
in Figure 32 will be obtained. 
 
The events with 50 or more participants have been highlighted (using Conditional 
Formatting). There are 10 such events. 
 

 

C: DATABASE 
The database Athletics Competition R2 2020.accdb contains information on athletes that registered to 

compete in the 2020 national athletics championships. The database comprises three tables, viz. 

tblAthletes, tblEvents and tblResults. The description of each field in the database is given in each table. 

Use the data in the Athletics Competition R1 2020 database to answer the following questions. 

Before answering questions in this section you should open each of the tables in Design View and read the 

descriptions of each field. 

It is also a good idea to study the relationships between the three tables. Go to the ‘Database Tools’ tab and 

click on ‘Relationships’ in the ‘Relationships’ group. Some of the questions require you to use data from more 

than one table. 

In any questions where filtering is applied to a table it is important to clear the filter before carrying on to the 

next question. 

Regional settings should be set correctly. The country or region 

should be South Africa and the Regional format set to English 

(South Africa). 

Access is fussy about dates being entered correctly. Short dates 

for the South African region should always be entered as 

yyyy/mm/dd. 

 

 

 

Figure 32 
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C1   According to the gender field how many female athletes are listed in the 
database? 

562 

Method 1: Filter table 
The gender field is found in the tblAthletes table. Open the table in 
Datasheet View. Apply filtering to the Gender field to only display females 
(see Figure 33).  
 
562 records are found (see 
Figure 34). 
 
 
 
 
 
 
 
 
 

 
Method 2: Select query 

Create a new select query. Go to the ‘Create’ tab and click on ‘Query Design’ 
in the ‘Queries’ group. Add the table tblAthletes to the query. Add the 
Gender field to the query design grid. Add the criterion ‘Female’ to the 
Gender field (see Figure 35). 
 
View the query in Datasheet View. 562 
records are displayed (see Figure 36). 
 
 
 

 
Method 3: Grouped query 

Create a new select query. Add the Gender field twice to the 
query design grid. In the ‘Design’ tab click on the ‘Totals’ 
button in the ‘Show/Hide’ group. A new row called ‘Totals:’ is 
added to the design grid. Change the second instance of 
Gender from ‘Group By’ to ‘Count’ (see Figure 37). 
 
 
 
 
 
 

Run the query. The output of the query shows that there are 
562 female athletes (see Figure 38). 
 
The criterion ‘Female’ could be added to the ‘Criteria:’ row of 
the first Gender field. In this case only the results for female 
athletes will be displayed. 
 
 
 
 
 
 
 

Figure 33 

Figure 34 

Figure 35 Figure 36 

Figure 37 

Figure 38 
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Method 4: Crosstab query 
Unlike select queries, it is much simpler to use 
a wizard to create a Crosstab query. The steps 
followed are very similar to those used to 
create a PivotTable in Excel.  
 
Create a new Crosstab query. Click on ‘Query 
Wizard’ in the ‘Queries’ group of the ‘Create’ 
tab. In the ‘New Query’ dialog box select 
‘Crosstab Query Wizard’. In the first step of the 
wizard select tblAthletes and click ‘Next’ to 
continue (see Figure 39). 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
In the next step of add the Gender field as the 
row heading (see Figure 40). Click ‘Next’ to 
continue. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 39 

Figure 40 
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Next select the Category field to be used as 
column headings (see Figure 41). Click ‘Next’ 
to continue. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

In the following step select the AthleteID field and 
the ‘Count’ function (see Figure 42). Click ‘Next’ to 
continue. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

In the final step of the wizard give your query a 
name. Leave the option button ‘View the query’ 
selected and click ‘Finish’ to view the output of 
the query (see Figure 43). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 41 

Figure 42 

Figure 43 
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The output of the query shows that 
there are 562 female athletes. 
 

C2   How many athletes were born in February 2002? 20 

Method 1: Filter table 
Open tblAthletes in Datasheet View. Apply a between filter to the DOB 
field (see Figure 45).  
 
In the ‘Between Dates’ dialog box set 
the ‘Oldest:’ date to 2002/02/01 and the 
‘Newest:’ date to 2002/02/28 (see 
Figure 46). Note that since 2002 was 
not a leap year February only had 28 
days.  
 

Click OK to apply the filter. 20 records are found. 
 
Method 2: Select query 

Create a new select query based on the tblAthletes table. Add 
the field DOB to the query design grid. Apply the criterion 
‘Between #2002/02/01# And #2002/02/28#’ to the ‘Criteria:’ row 
of the design grid (see Figure 47). Access will automatically add 
the ‘#’ signs but it is a good idea to type them in yourself. 
 
Run the query. 20 records are returned. 
 

 
Note: To access the Zoom tool, click in the ‘Criteria:’ row and press <Shift><F2>. Adjust the font size by 
clicking the ‘Font…’ button. 
 
 
 
 
Method 3: Crosstab query 
Create a new Crosstab query using the Crosstab query wizard. Base the query on the tblAthletes table. 
Choose the DOB field as row headings and the Category field as column headings. Count the AthleteID 
field. The query will count all dates of birth in the table and will need to be modified to only display dates 
of birth in February 2002. 
 

View the query in Design View. In the 
query design grid add the field DOB in the 
first empty column at the right of the grid. 
Change the ‘Total:’ row to show ‘Where’ 
which allows for a criterion to be added. 
 
In the ‘Criteria:’ row add the criterion 
‘Like “2002/02/*”’ (see Figure 48). The 

wildcard (‘*’) is used to choose all possible days in February 2002.  

Figure 45 

Figure 46 

Figure 47 

Figure 44 

Figure 48 
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View the query in Datasheet View. The number of athletes who 
have birthdays in February 2002 are shown in the second column 
(see Figure 49). Click on the ‘Total’ button in the ‘Records’ group 
of the ‘Home’ tab. Select the ‘Sum’ function from the dropdown 
at the bottom of the ‘Total of AthleteID column. A total of 20 
athletes is displayed (see Figure 49). 
 
It is also possible to simply add up the totals in the ‘Total of 
AthleteID’ column. 

C3   A ‘DNQ’ in the tblResults table means that the athlete failed to qualify for the next 
round of an event in which they were competing.  

C3   In which event did Anthea Godfrey fail to get into the next round? 

SF200m 

All three tables will need to be used to answer this question. The athlete’s name is stored in tblAthletes, 
the ‘DNQ’ is found in tblResults and the event code is in tblEvents. The event code which gives the 
category, gender and event name is required in order to give the specific event which Anthea Godfrey did 
not qualify for. 
 
Method 1: Filtering 

In tblAthletes apply a filter to either 
the Surname field (equals ‘Godfrey’) 
or the FirstName field (equals 
‘Anthea’) or the FullName field 
(equals ‘Anthea Godfrey’) (see 

Figure 50 for the results of filtering for the first name). The athlete found has an AthleteID of 351. This 
value is used as the foreign key in tblResults and can be used to find Anthe Godfrey’s results. 
 
If you click on the + at the beginning of the 
record for Anthea Godfrey, a list of the 
result or results for this athlete will be 
displayed. This shows two results. The 
result for the event with EventID 31 was the 
event where the athlete did not qualify for 
Round 2 (see Figure 51). 
 

In tblEvents apply a filter to the 
EventID field (equals 31). This 
is event is the senior female 
200 m race. Use the event code 
SF200m as your answer (see 

Figure 52). 
 
 
 
 
 
 
 
 

Figure 50 

Figure 51 

Figure 52 

Figure 49 
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Method 2: Select query 
Create a new query. Add 
tblAthletes, tblEvents 
and tblResults to the 
query grid (see 
Figure 51). 
 
 
 
 
 
 

Add the following fields to the query grid (refer to Figure 53): 
 
tblAthletes FirstName and Surname 
tblEvents EventCode 
tblResults Round2 
 
The fields can be added to the query grid in any order. 
 
Add the criterion ‘Anthea’ to the FirstName field and the criterion ‘Godfrey’ to the Surname field.  
 

Run the query and view the results in Datasheet 
View (see Figure 54). 
 
The event for which Anthea Godfrey did not qualify is 
SF200m. 

 
 

  

Figure 53 

Figure 54 
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C4   Give the surname of the athlete that qualified fastest for the SF2 (semi-final 2) in 
the junior girls 100 m race. 

Haupt 

Care must be taken when answering this question. The time used to qualify for semi-final 2 is the time 
obtained in round 1. The qualifying time was the time used to qualify for the first round of the competition. 
 
Method 1: Filtering 

The event code for the junior girls 100 m race is 
JF100m. Filter tblEvents to find this record. It turns 
out to be the first record in the table (EventID of 1).  
 
Expand this record to show all the linked records in 
tblResults (see Figure 55).  
 
 
 
 
 
 

 
Filter the records in the linked results to show ‘SF2’ 
for the Round2 field. Sort the Round1 field from 
smallest to largest so that the fastest time is the first 
record (see Figure 56). 
 
The AthleteID of the athlete with the fastest time in 
Round 1 is 396. 
 
 
 

Filter tblAthletes to find the record for the athlete with 
AthleteID equal to 396. The surname of the athlete is 
Haupt (see Figure 57). 
 
 
 

 
Method 2: Select query 

Create a new select query based on all three 
tables in the database (see Figure 58).  
 
 
 
 
 
 

Add the following fields (in any order) to the query grid (refer to Figure 50): 
tblAthletes: Surname 
tblResults: Round1 and Round2 
tblEvents: EventCode 
 
Add the criterion ‘SF2’ to the Round2 field and the criterion ‘JF100m’ to the EventCode field. Sort the 
Round1 field in ascending (smallest to largest) order. 
 

Figure 55 

Figure 56 

Figure 57 

Figure 58 
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Run the query and view the results in Datasheet 
View (se Figure 59). 
 
The surname of the athlete with the fastest time in 
Round 1 is Haupt. 
 

C5 An error was made when capturing the ID number of one of the athletes. The 
birthdate part of the ID number does not match their date of birth. What is the 
surname of the athlete whose ID number was captured incorrectly? 

C5   Finding and ID number that doesn’t match the birthdate 

Currie 

The first six digits the identity number give the athlete’s birthdate in the format ‘yymmdd’. The SAID field is 
a text field. The dates of birth are stored in the DOB field as a date/time field (a number giving the number 
of days from 1900/01/01 is actually stored). To find the incorrect date of birth/ID number pair it is necessary 
to extract the first six digits of the ID number and convert the date of birth from ‘yyyy/mm/dd’ to the text 
‘yymmdd’. The two methods below show two diffent approaches to solving this problem. Both make use of 
functions which are not part of the CAT curriculum. 
 
The date of birth and ID number are both stored in the tblAthletes table. 
 
Method 1: Select query with calculated fields 
Create a new query based on tblAthletes see Figure 60 below).  
 

 
Add the Surname field to the query grid. 
 
Add three calculated fields to the query grid: 
 
BDateID: Left(SAID),6) – this extracts the first six digits from the ID number 
BDateDOB: Format([DOB], “yymmdd”) – this converts the date of birth to a text string with a format 
which matches the text string from the ID number 
 
The third calculated field (call ‘Oops’) check for cases where the two date strings do not match. This is 
done using the IIf() function. This is similar to the IF() function in Excel. Both ‘value if true’ and ‘value if false 
MUST be given. 
 
Oops:IIf([BDateID]<>[BDateDOB],”Error”,”OK”) 
 

Figure 59 

Figure 60 
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Run the query and filter 
the output of the ‘Oops’ 
field for ‘Error’.  
 
This returns one record 
where the athlete with the 

surname of Currie is found. 
 
Method 2: Select query with calculated fields 
Create a new select query based on tblAthletes (see Figure 62 below). 

 
Add the fields Surname, DOB and SAID to the query grid. Add a calculated field called ‘Error’ to the query 
grid.  
 

 
The calculation for the ‘Error’ field is shown in Figure 63. This calculation uses the DOB field and looks 
extremely complicated. It needs some explanation: 
 
The first part of the calculation uses the Mid() text function together with the Year() date function to extract 
the last two digits of the year. The second part of the calculation uses Month() date function to extract the 
month number. An IIf() function is used to add (concatenate) a leading zero in the cases where the month 
number is only a single digit. A similar combination of the Day() and IIf() functions is used to extract the day 
and add leading zeros where necessary. 
 
The criterion of the calculated (‘Error’) field, ‘<>Left([SAID]),6)’, checks for cases where the first six digits 
of the identity number do not match the date of birth (see Figure 62). 
 

Run the query. A single record is returned. 
The surname of the athlete with an error is 
Currie (see Figure 64). 
 
 

 

  

Figure 61 

Figure 62 

Figure 63 

Figure 64 
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C6   How many distinct events are there on the programme?  
(NB. For the purposes of this question the word distinct means that all the 100 m for 
females and all the 100 m for males count as a distinct event.) 

16 

Method 1: Select query 
Create a new select query based on tblEvents. Add a the field EventName to the query grid. The 
EventName field is used as each event, e.g 100 m, need only be 
counted once. 

Ensure the Property Sheet is visible 
by clicking on the ‘Property Sheet’ 
button in the ‘Show/Hide’ group of 
the ‘Design’ tab (see Figure 65). 
 
 
 
 
In the property sheet for the query change the value for ‘Unique Values’ to 
‘Yes’ (see Figure 66). This will display unique values in the EventName field 
when the query is run. 
 
 
 
 
 
 
 

 
Run the query. Sixteen (16) records are displayed (see Figure 67). The  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Method 2: Grouped query 

Create a new select query based on tbtEvents. 
Add the EventName field to the query grid twice. 
On the ‘Design’ tab click the ‘Totals’ button which 
is in the ‘Show/Hide’ group. In the ‘Total:’ row 
change the second EventName from ‘Group By’ to 
‘Count’ (see Figure 68). 
 

Figure 65 

Figure 67 

Figure 66 

Figure 68 
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Run the query. Sixteen (16) records are returned (see Figure 69). 
 
The ‘Totals’ button in the ‘Records’ group on the ‘Home’ tab can 
be used to add a ‘Count’ function to the output of the 
‘CountOfEventName’ column. 
 
 
 
 
 
 
 
 
 
 
 
Method 3: Remove duplicates in Excel 
Open tblEvents in Datasheet View. Click on the heading of the EventName field to select all the records in 
the field. Copy these recordsa and paste them in an empty worksheet in an Excel spreadsheet. 
 

In the spreadsheet select the records pasted from Access. Click on the 
‘Remove Duplicates’ button which is in the ‘Data Tools’ group on the 
‘Data’ tab. In the ‘Remove Duplicates’ dialog box accept all the default 
settings (see Figure 70). 
 
Click OK. A message box 
appears showing the 16 unique 
values remain (see Figure 71). 
 

C7  In order to gain entry to the competition athletes need to qualify by getting a time 
less than the qualifying time, or a height greater than the qualifying height, or a 
distance greater than the qualifying distance. What is the first name of the junior 
female athlete that had the greatest improvement between her qualifying height for 
the high jump and the height she achieved in Round 1 of the competition? 

C7   Who had the greatest height improvement? 

Kolbe 

This question does not lend itself to being solved using filtering as there is a many-to-many relationship 
between athletes and events. A select query is the best option. 
 
Create a new select query based on all three tables (see Figure 72). 
 

 
 
 
 

Figure 69 

Figure 70 
Figure 71 

Figure 72 
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Add the following fields to the query grid: 
 
Surname, Gender and Category from tblAthletes 
Qualifying and Round1 from tblResults 
EventName from tblEvents 
 
Add the following criteria: 
 
Gender → Female 
Category → Junior 
EventName → High Jump 
 
Add a calculated field to the query grid: 
 
Improvement:[Round1] - [Qualifying] 
 
Sort the caculated field (Improvement) in descending order (from largest to smallest) (see Figure 72). 
 
Run the query and view the output. 

The surname of the athlete with the greatest improvement will be the first record of the output. Her surname 
is Kolbe. 

C8   What is the R1 time difference (in seconds) between the fastest male and fastest 
female for the 100 m races?  
Consider only the junior age group. (Give your answer to two decimal places e.g. 1.23). 

1.18 

Solving this question first requires identifying the 100 m times of the fastest athletes in each gender. 
Thereafter a number of strategies can be followed to determin the time difference. Note that results for Round 
1 should be used. 
 
Step 1: Select query 
Create a new select query based on all three tables (see Figure 74). 

 
 
 
 
 
 
 
 
 

 
Add the following fields to the query grid: 
 
Gender and Category from tblAthletes 
EventName from tblEvents 
Round1 from tblResults 
 
 
 
Add the following criteria: 

Figure 73 

Figure 74 
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Category → Junior 
EventName → 100 m 
 
Sort the Round1 field is ascending order (smallest to largest) so that the best (fastest) time appears at the 
top of the output. 
 
Run the query and view the output. 

 
The time (10.17) of the fastest male athlete appears 
in the first record of the output (see Figure 75). 
 
 
 
 
 
 
 
Scanning down the output you will find the time for 
the fastest female athlete (11.35) in record 23 (see 
Figure 76). Filtering could also be used to find the 
time of the fastest female athlete. 
 
 

Step 2: Calculate difference 
The difference between the times of the two athletes is 11.35 - 10.17 which is equal to. 1.18. This can be 
determined in a number of different ways: 

• Mental Arithmetic 

• Pen(cil) and paper 

• Use the Calculator app on the computer or your phone 

• Use a pocket calculator 
 
Modified query 

Instead of the select query used above a parameter query could also be used. 
This query will ask for the gender of the athlete each time it is run. 
 
Add the criterion ‘[Enter gender: ]’ to the Gender field (see Figure 77). 
 
When the query is run an input box appears 
where the gender must be entered (see 
Figure 78).  
 
Run the query twice entering ‘Female’ and 

then ‘Male’ in the ‘Enter gender:’ box. Note that the gender must be typed 
in in the same way that it is captured in the Athletes table. The times can 
be found in the top row of the output in each case. 

 

Figure 75 

Figure 76 

Figure 77 

Figure 78 


